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About RefWorks
http://refworks.scholarsportal.info

RefWorks is a citation management program, which lets you download citations
from databases such as Biological Abstracts, MEDLINE, or the library catalogue, into
folders that you create in your RefWorks account. It also formats in-text citations and
Reference lists in Word docs in the style of your choice (CSE or APA).

For information about using Refworks with databases available at York, please refer to
the RefWorks pages on the York University Libraries Website: from the YUL homepage
(http://www.library.yorku.ca), select RefWorks.
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Building a RefWorks Database

1. Exporting book/item records from the York Catalogue to RefWorks:
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a. Click on the title of the book to view the full record| ;. s mors:  Brown, witiam ard
Published- 2010
b. Login into Passport York Lygin to save, email and export this item
D34184
c. Export the record into RefWorks | Socfiitee Sigento Sl ooz e
« Prev #2 of 1396 Next » Add to My List J Texttnis 4] Emall this ng_w

Darwin /
adited by William Brown and Andrew C. Fabian.

For more information on using RefWorks, select RefWorks under the RESEARCH tab
on the Library homepage <www.library.yorku.ca> and scroll down


http://www.library.yorku.ca/
http://www.yorku.ca/yorkweb/index.htm�

2. Importing records from library catalogues when you are in RefWorks
(including the York Library catalogue)
Within RefWorks: Select the Online Catalog or
Database option from the Search menu and then select the
catalogue you wish to search using either the quick or
advanced search options provided.

3. Entering records manually: Within RefWorks, select | Reerences g
Add New Reference from the References menu and then m
enter citation information in the appropriate fields. f imoort o Lo
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Ref ID:

Indicate the Output Style (View fields used by:), as
well as the target Folder for saving the reference,
the Reference Type, and the Source Type. The
Fields that need to be entered into the record for
that style will appear when you select a style.
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Add attachment

You can also Choose File to add as an attachment
such as the notes, annotations or reports you have
written while analyzing the article or book.
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Fields used by Council of Science Editars - CSE 7th, Mame-Year
Sequence

The following fields are used by your selected output style. You can access
additional fields below.

Notes can also be recorded in the Personal Notes
field of the record

4. Selecting an Output Style: From the View fields used by dropdown menu, click
on Access Output Style Manager to select a Style such as APA, MLA, CBE etc.
There are hundreds of journal styles to choose from.
View fields used by: . The Outpu_t Style Manager Bibliography
In Folderis 22 vorites o is also available from the oot
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Qutput Language Equn;éLDédSigiigrqce Editors - CSE 7th, Mame- " Output Style Editor
AttachmentsYOrk University Specific )
apa - american Psychological Association, St » Previews Output Style
Authors  MLA 6th Edition
Access Qutput Style Manager...
5. Directly exporting citations from databases/indexes to RefWorks: A list of

databases/indexes for which direct export of citations is supported is available on
the YUL RefWorks WebPages (location noted at bottom of page).

http://www.library.yorku.ca/Z/ccm/Home/ResearchAndlInstruction/citationmgmt/index

Databases for which the direct export feature is available will offer an export to
RefWorks option (typically once a results list has been retrieved or you have
requested to SAVE or EXPORT citations; this will appear as one of the output

options).

For more information on using RefWorks, select RefWorks under the RESEARCH tab
on the Library homepage <www.library.yorku.ca> and scroll down


http://www.library.yorku.ca/ccm/Home/ResearchAndInstruction/citationmgmt/index

When the Direct Import is either not available, or not functioning, use the

Indirect Import protocol:

6. Indirectly exporting citations from databases/indexes to RefWorks: The
directions below pertain to many databases/indexes that support indirect export of
citations; however, individual databases may behave differently and you are
encouraged to refer to the instructions provided on the YUL RefWorks Web

Pages (location noted at bottom of page).

Indirect export of citations involves saving citations in a text file and importing data

from these saved files into RefWorks.

1. Once results have been retrieved from the database/index References

searched, save them as a .txt file.

der
2. Access your RefWorks account and select ‘Import” from the H F
¥po

References menu.
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3. ldentify the relevant import filter/data source (e.g. GALE InfoTrac Web) and
database (e.g. Multiple Databases). Select the folder you wish to import to, and
the .txt file to be imported, by using the browse file option. Click on Import.

6. Ref-Grab-It for capturing citation information from a web page:

1. Follow the instructions for downloading the Ref-Grab-It
bookmarklet into your favourites in Internet Explorer or

bookmarks in Mozilla.

2. Locate the website you want to add
to your references and capture the title,
URL, and access date using the
Ref-Grab-It bookmarklet from the
bookmarks or favourites lists.

3. View the RefWorks record in the Last Imported Folder,
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For more information on using RefWorks, select RefWorks under the RESEARCH tab
on the Library homepage <www.library.yorku.ca> and scroll down



4

4. Click Edit to add the missing information located in the website such as the Author

name, the last update date and publisher.
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Year:| 2011

Accessed,
Year: 2011

Accessed,
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Publisher: ServiceOntario Publications|

Place of
Publication: Toronto, Canada
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Versiom

Editing and Organizing your RefWorks Database

Several options are available:

Folder Management

New records imported into RefWorks will automatically
be added to the Last Imported Folder. They should be
moved to a permanent folder.

You can create as many new folders as you want to
organize your imported citations. E.g. one for each
course or each paper or lab report.

To move selected records into a folder, mark the records
you wish to move, click on the Add To icon, and then
select the folder to which they are to be moved from the
drop-down menu.

Checking for Duplicates
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You can identify both exact matches and close matches by selecting the

Duplicates option from the View menu.
Global Edits
Author, descriptor, or periodical names can be edited glo

bally by selecting

Descriptor, Author or Periodical Name from the Search Menu and then selecting
the descriptor, author, or periodical name to which a global edit is to apply.

Searching your RefWorks Database

Quick Search using the searchbox in the toolbar - searches all fields.
Advanced Search - in the Search Dropdown menu, limits search to specific
selected fields with an option to use Boolean operators. To add fields click on: @
Lookup Up Indexes — available for authors, descriptors, and periodical names.

For more information on using RefWorks, select RefWorks under the RESEARCH tab
on the Library homepage <www.library.yorku.ca> and scroll down




Writing the Paper and Formatting a Bibliography Using Write ‘n Cite

MS Word and Word for Mac users can employ ‘Write ‘N Cite’ to embed references from
their RefWorks database into their essays as they write a paper. This utility is a plug-
in, which can be downloaded to an individual user’s computer directly from their
RefWorks account.

Download Write ‘N Cite from the RefWorks Tools Menu and select
Write ‘N Cite to activate the Installation Wizard.

N.B. To insert citations into a Word document, the document
must first be saved.

Inserting citations:

1. Open a new document in Microsoft Word and save it. This is the working
document that you save for edits, additions, etc. From this you generate a
“final” version for handing in, sending off for publication, etc. Begin writing the
paper. Position the cursor where you wish to embed a citation.

2. Click on the Write ‘N Cite icon within Word.

3. This takes you to a mini version of RefWorks. You will need to log in, even if you
are already logged into the main RefWorks program.

4. Locate the folder containing the references for this paper (from the View drop-
down menu), and click Cite.

5. Citations can be edited to add page numbers, lead-in or following text, etc.

o ommith, Prime-Tine Telewision: Assessing Violence dunng the Most
Cike Wiew |:||:| . .
élh?] stacy L. Popular Viewing Hours

6. Save your document.

Creating a Bibliography in RefWorks

There are 2 ways that RefWorks can automatically create a bibliography from
references in your database.

1. Format your paper’s citations and create a bibliography from Write ‘N Cite:

In Write ‘N Cite, click on Bibliography.

Select the output style you wish to apply.

Click on Create Bibliography.

The Word document will re-format in the “Final” version with in-text citations
and reference list in the style that you have chosen.

5. You can add citations to the re-formatted document, and format again.

PONPE

CHECK EACH REFERENCE IN YOUR BIBLIOGRAPHY FOR ACCURATE FORMAT
as RefWorks is not always accurate!

For more information on using RefWorks, select RefWorks under the RESEARCH tab
on the Library homepage <www.library.yorku.ca> and scroll down



2. Format citations in your paper and create a bibliography from the main
page in RefWorks:

1.
2.

In Refworks, click on Bibliography - Create.
Select one of two options:
a. Format Paper and Bibliography
i. Browse for the document that you want to format.
b. Format a Bibliography from a List of References
i. Choose the folder containing the references you wish to format
ii. Determine how you would like the bibliography created (as a
WebPage, MS Word document, etc.)
Click on Create Bibliography.
The Word document will re-format in the “Final” version with in-text citations
and reference list in the style that you have chosen.

Listof Qutput Stles Reduest Mew Output Stile
Outpart Style: Council of Science Editars -1 »
Output Stvle Manader Preview Output Style

Format Paper and Bibliography <

Document to Format:

CADocuments and Bettil

Format a Bibliography from & List of References ¥ ot

Create Bibliography
i

Getting Help

RefWorks help is available:

1. From the Help Menu, select Tutorial and locate the short video of the feature
you want to see.
2. Send an e-mail to refworks@yorku.ca. A librarian will respond within one
working day.
3. Librarians at the libraries’ reference desks are also able to provide assistance.
REFSHARE

To share your folders with other students or other group members, click on the
Organize & Share Folders tab

r ; distance ¢
References I Organize & Share Falders
- Faculty-Li
“rou have O reference(s) not in folders. Duplicates not in folders. #= \iew Shared Area LM_'I Statistics o Default Settings

Health Tu
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& Lastimported (1) < Rename FD'“Ef{b Remi_b Share

@ Clear Folder = i
Collections Course for Librarians — (5) % Shared Folder Options
. | _ Peiete Foider 4 Email this share

Click on the folder icons to perform functions such as creating a subfolder, clearing the

Duplicates

folder, etc OR creating a link for sharing OR putting on Reserve for your course.
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For more information on using RefWorks, select RefWorks under the RESEARCH tab
on the Library homepage <www.library.yorku.ca> and scroll down
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